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[bookmark: _Toc24368435]HOW SHOULD THE GUIDELINES BE USED?

The University Thesis and Dissertation Guidelines describe the design, arrangement, and appearance of theses and dissertations at UWL. All departments at this university use the Guidelines as a standard, and the editor will use them to assess each completed thesis or dissertation in order to determine if it can be approved by the university. The University Thesis and Dissertation Guidelines contain the only requirements for style and format that a student will need, although a more detailed guide to APA-style citation and reference (available online and in print) may also be useful.

When an advisor suggests format changes and standards for a manuscript that conflict with the University Thesis and Dissertation Guidelines, the student and advisor are encouraged to contact Graduate Studies to determine which standard is correct. 

There are several reasons why the University and Graduate Studies place so much importance on what may seem to be tedious or miniscule details of format. First, the University holds an attitude common in academia: attention to detail in format is an indication of disciplined scholarship in research and inquiry. Careless errors in format may reflect poorly on the quality of methods used and conclusions drawn by the writer. Additionally, scholarly publications desire uniformity of style and organization to allow readers to locate information efficiently and to compare articles on similar subjects; the University Thesis and Dissertation Guidelines are meant to foster this same consistency and ease of access in the diverse theses and dissertations written at this institution.  

Finally, all students’ theses and dissertations will be archived in the university library, and future students may use them as scholarly references and as examples of how to format their own manuscripts. For this reason, among many others, every thesis and dissertation must embody the standards of format, style, and organization described in the University Thesis and Dissertation Guidelines. 

[bookmark: _Toc24368436]ABOUT THE FORMATTING GUIDELINES

These guidelines are designed to guide students through the thesis and dissertation formatting process.  The goal is to keep the formatting as simple as possible, while at the same time providing uniformity and consistency across all graduate programs at UWL. 

Ordinarily, a seminar paper or capstone project report does not have to be approved by the Dean of Graduate & Extended Learning.  However, if the seminar paper or capstone project is deemed to be of appropriate rigor and quality and the graduate program wishes it to be archived in Murphy Library, the student must follow the same rules as they would for a thesis or dissertation.
NOTE: Your department/program may have additional requirements related to the completion of theses and dissertations, including required forms. See your program’s website or graduate handbook for more information. 
[bookmark: _Toc24368437] STYLE REQUIREMENTS

In cases where students intend to publish (or have already published) chapters of their thesis or dissertation as a manuscript, they can choose to follow the guidelines for a particular journal rather than the University Guidelines. In such cases, students must provide the journal manuscript guidelines (usually available as a “Guide to Authors” page of the Journal website or in the first or last issue of the volume) to the editor at the time of submission, along with a copy of a recent article from the journal. Please note, however, that when the thesis or dissertation is written following the guidelines of a target journal for publication, the formatting guidelines of this document must be followed for the title page, signature page, acknowledgments, table of contents, list of tables, list of figures, and appendices. If a student has any questions about style, they should discuss it with their thesis or dissertation chairperson. 

[bookmark: _Toc24368438]Front Matter

The front matter of the thesis or dissertation consists of the title page, signature page, abstract, acknowledgments (if desired), table of contents, list of tables, list of figures, and list of appendices, all appearing in the order listed. See the “Pagination” section below for details on page numbering.

[bookmark: _Toc24368439]Title Page and Signature Page

The title page and the signature page should follow the templates found in Appendix A. The page number is hidden on these two pages of the front matter. 

For the signature page, use the official name of your degree, found in the Graduate Catalog online. 

[bookmark: _GoBack]An electronic signature is acceptable on the signature page. 

[bookmark: _Toc24368440]Abstract

The abstract page consists of a title portion and a summary portion.  A template for the abstract page is found in Appendix A. A layout of the title portion can be seen below:
ABSTRACT
Student Last Name, First Initial. Second Initial. Title of the manuscript. [MS/MPH/Ed.D.] in [program name], Month and Year of Graduation, ##pp. (Advisor’s First Initial. Last Name)






The abstract title should be the same descriptive title used for the title of the project and should be underlined.  Only one space is needed after the periods within the title portion of the abstract. Only the first word of the title on the abstract page is capitalized, unless the title contains proper nouns (e.g. scientific or commercial product names).  The page count (##pp.) includes the front matter (all pages paginated with lower case Roman numerals) and the main text/references/appendices (all pages paginated with Arabic numerals).  Thus, a manuscript with seven pages of front matter (vii) and fifty-three pages of main text (53) would have a page count of sixty pages (written as “60pp.” in the title portion).  The advisor’s name should be listed last, as seen above in the example.

The summary portion of the abstract page is a summary of the overall study, including the statement of the problem and a brief description of the subject under investigation. It should be a “free-standing” summary of the manuscript.  The first line should be left-justified (i.e.: no indent is used), and it should be single-spaced (with a double-space between the title portion and the summary portion).  The abstract summary should not exceed 200 words.  

The abstract page is the first visibly numbered page of the front matter with a lower case Roman numeral “iii”.  (The first two pages, the title page and signature page, have their page numbers hidden but do count towards the total page count.)

[bookmark: _Toc24368441]Acknowledgments

An acknowledgments page is optional.  Its heading should be centered and in all capital letters.  Between the heading and the text should be a double-space.  The text should be double-spaced, and indents should be used at the beginning of each paragraph. The function of this page is to recognize those who gave the student special assistance and/or to give recognition to entities who may have provided funding for the student’s work.

[bookmark: _Toc24368442]Table of Contents

The Table of Contents should contain the main section headings and three levels of subheadings (APA levels 1, 2, and 3 – see Levels of Headings section below). Only items coming after the Table of Contents are included within it. The Table of Contents should be double-spaced between entries and have a dotted line connecting the heading and the page number.  The PAGE numbers should be right-justified. An example Table of Contents is shown below. 

If you use the Styles tools in Word to designate your Heading levels, you can insert an automatic Table of Contents from the References tab. Instructions are available online. 
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[bookmark: _Toc24368443]Lists of Tables, Figures, and Appendices

A List of Tables, List of Figures, and List of Appendices will be provided after the Table of Contents if three or more of each of the tables, figures, or appendices are included, respectively. If there are fewer than three tables or figures, they do not need to be listed within the Table of Contents. If there are fewer than three appendices, they may be listed simply as Appendices, as shown above, but without the list of appendices entry. Each entry will be double-spaced with a dotted line connecting the heading and the page number. Each entry should contain the number of the table/figure/appendix and the title.  This should be structured the same as the Table of Contents. In the case of a lengthy table or figure title, the title may be shortened in the List of Tables or List of Figures to the first common point of punctuation (such as a comma, semicolon or colon). An example List of Tables is shown below.

LIST OF TABLES

TABLE						                  PAGE

1. Demographic Information of Online and Traditional Students………… 10

2. Course Performance of Online and Traditional Students……………......10

3. Satisfaction Information of Online and Traditional Courses…………… 12

4. Perceptions of Online Students…………………………………………  14



[bookmark: _Toc24368444]

Margins

The margins on the top, bottom and right side of each page should be 1 in. (2.54 cm).  The left side margin needs to be 1.5 in. (3.81 cm) to allow for the binding (note: for this reason the thesis or dissertation must be printed single-sided). The first page of text (usually the first page of the Introduction) should have a 2 in. (5.08 cm) top margin. In a chapter style thesis or dissertation, each chapter title should be placed 2 in. (5.08 cm) from the top of the page. With the exception of headings and the beginning of new paragraphs, all text should be aligned on the left side of the page. These margins must be maintained for tables, figures, references, and all appendices.

[bookmark: _Toc24368445]Justification

The left margin of all text must be justified.  A one tab indent is used at the beginning of each new paragraph. The right margin should not be justified.

[bookmark: _Toc24368446]Spacing

All text should be double-spaced with very few exceptions. Hypotheses, if used, are blocked and single-spaced. Exceptionally lengthy quotes and footnotes can be single-spaced.  In addition, the abstract is single-spaced.  References are single-spaced with double-spacing between entries. 


[bookmark: _Toc24368447]Pagination

The thesis or dissertation is paginated with Roman numerals for the front matter (i.e., abstract, acknowledgments, table of contents, list of tables, list of figures, and list of appendices). The counting of front matter pages begins immediately with the title page and continues sequentially through the list of appendices; however, page numbers should be hidden on the title page and the signature page. The first visible page number (i.e., page iii) will appear on the abstract page.

The thesis or dissertation is paginated with Arabic numerals for the main body text, the reference pages, and any appendices. The counting of page numbers begins immediately with the first page of the Introduction (for manuscript-style theses) or Chapter I (for chapter-style theses or dissertations) and continues through the appendices. All page numbers are visible in the main body text and reference pages, including the first page (i.e., page 1). The page numbers should be hidden on the appendix title pages (e.g. Appendix A, Appendix B, etc.), but visible on the appendices.

[bookmark: _Toc84922739]All page numbers should be centered, 0.5 in. (1.25 cm) from the bottom of the page. Make sure the page number font matches that of the main text. 


[bookmark: _Toc24368448]Levels of Headings 

Main section headings [CHAPTER I and CHAPTER TITLE (for a chapter-style thesis or dissertation) or INTRODUCTION (for a manuscript-style thesis or dissertation)] should be printed in ALL CAPITAL LETTERS, centered, boldface, and 2 in. (5.08 cm) from the top of a new page.   In the case of a chapter-style thesis or dissertation, CHAPTER I is first and the chapter name (e.g. INTRODUCTION) is centered two lines below. Chapters should be numbered using capital Roman numerals. There should be a double-space after these headings, and then the text should begin (with an indent).  See below for an example of all the levels of headings.  The main section headings and three levels of subheadings are listed in the table of contents.

The first level of subheading is a centered, boldface, uppercase and lowercase heading. The first letter of each main word is capitalized (i.e., it is written in title case).  There should be a double-space before and after this level of subheading.  This level of subheading must be listed in the table of contents.

The second level (subheading) is a flush left, boldface, uppercase and lowercase heading. The first letter of each main word is capitalized (title case).  There should be a double-space before and after this level of subheading.  This level should be listed in the table of contents.

The third level (subheading) is a flush left, boldface, italicized, uppercase and lowercase heading. The first letter of each main word is capitalized (title case).  There should be a double-space before and after this level of subheading.  This level should be listed in the table of contents.

The fourth level (subheading) is an indented, boldface, uppercase and lowercase paragraph heading ending with a period. The first letter of each main  word is capitalized (title case). There should be a double-space before this heading, and text begins after the period on the same line as this heading.  This level should not be listed in the table of contents.

The fifth level (subheading) is an indented, boldface, italicized, upper and lower case heading ending with a period. The first letter of each main  word is capitalized (title case). There should be a double-space before this heading, and text begins after the period on the same line as this heading.  This level should not be listed in the table of contents.


Examples are:

MAIN SECTION HEADINGS 

First Level of Subheadings (APA 7th edition Level 1)

Second Level of Subheadings (APA Level 2)

Third Level of Subheadings, if Needed (APA Level 3)

	Fourth Level of Subheadings, if Needed. (APA Level 4)

	Fifth Level of Subheadings, if Needed. (APA Level 5)

Headings or subheadings beginning at the bottom of a page require at least two lines of text after the heading and two lines at the top of the following page.

[bookmark: _Toc24368449]Type Face & Quality

The selection of font and type size affects the overall appearance of the document. It is highly recommended that you adhere to a 12-point font in Times New Roman, and use the same font throughout the manuscript.  A smaller, though no smaller than 10-point font, may be used for items such as tables, figures and footnotes. The final copy should be of sufficient quality to maintain consistently clear and dense characters. The use of bold characters is only allowed for main section headings and subheadings and should not be used in the body of the text or in the front matter (title page, signature page, abstract, acknowledgments, table of contents, or lists of tables/figures/appendices).  Italics may be used to denote significant emphasis on special words within the body of the text.

[bookmark: _Toc24368450]Block Quotations

[bookmark: _Toc84922749]Blocked quotations are used with long quotations of 40 words or more.  They are placed in a freestanding block without quotation marks. The blocked text begins on a new line and the entire block is indented 0.5 in. (1.27 cm or 5 spaces). The original paragraphing should be retained and the author, year, and specific page number(s) should be listed.

[bookmark: _Toc24368451]Tables

Tables may be formatted according to the APA 7 guidelines or as described below. Students in the sciences are encouraged to use the directions provided here, since the APA formatting for tables is quite different from what you are used to. 

Tables communicate important information to the reader and should be composed in such a way that they enhance the understanding of the project and/or the results.  Tables should stand alone and be referenced and explained within the text, but information should not be duplicated in both.  A table should appear as close as possible to the text in which it was discussed, usually no farther away than the following page.  Multiple tables can be placed on the same page if space allows. Vertical lines should not be included in any tables unless they are required according to the journal formatting guidelines being followed. 

The title of the table includes an Arabic numeral and a descriptive title. The title should be in the same font and size as the rest of the text.  The title is followed by a double-space before the table is inserted.  All text in the table should be readable (no smaller than 10 point) and in the same font as the text.  The table should be followed by a double space before text or another table.  If there are fewer than three tables in your manuscript, they should be listed individually in the table of contents and no List of Tables page is needed.  If there are three or more tables then a list of tables should be included.  If tables are included in the appendix they should also appear in the List of Tables, and the enumeration of the tables should continue from those listed in the text.  Long tables may be placed on more than one page.  

Oversized tables may also be placed in landscape format.  In landscape format, the right side should be the bottom of the table. In this orientation, the proper page margins and page numbers must be adhered to as if the table were in a portrait orientation (left, right and bottom margins at 1 in., top at 1.5in.).  The individual program manuals have different requirements for tables.  Be sure to follow the specifications of the manual for your area of study.  An example of a table is given below. 
[bookmark: _Toc84922742]
Table 1.  Demographic Information of Online and Traditional Students
________________________________________________________________________

					Online				Traditional


Age*				    21.94 ± 7.62		    18.47 ± 0.61
Gender				    Male = 5, Female = 13	    Male = 6, Female = 13
Year in School* #		     2.35 ± 0.86			    1.16 ± 0.50
On-Campus Housing		   55.6%			    84.2%
Employment Status*		   Part Time: 72.2%		    Part Time: 36.8%
				   Not Employed: 22.2%	    Not Employed: 63.2%
				   Full Time: 5.6%		    Full Time: 0%

*Reached 0.05 level of significance
#Scale: 1 = Freshman, 2 = Sophomore, 3 = Junior, 4 = Senior

[bookmark: _Toc24368452]Figures

Figures may be formatted according to the APA 7 guidelines or as described below. Students in the sciences are encouraged to use the directions provided here, since the APA formatting for figures is quite different from what you are used to. 

Any diagram, graph, chart, map, photograph, or other type of illustration is designated as a figure.  Figures follow many of the same guidelines as tables.  Figures are especially effective in demonstrating interaction effects or nonlinear relationships to the reader. 

All figures should be incorporated into the text of the document and should be placed as close as possible to the related discussion but no farther than the following page. Figure legends should be placed outside of the figure, one double-space below the figure. They should be numbered consecutively in Arabic numerals (e.g. “Figure 1.”, “Figure 2.” etc.). Any figures placed in the appendix should continue the sequence and be included in the List of Figures.  The same rules apply for figures as for tables: if fewer than three, list them in the table of contents.  If you have three or more you must include a List of Figures page. 

Multiple figures may be placed on the same page if the titles can be placed in their proper position and if adequate space can be maintained between figures. A double-space is required between any figure information and the body of the text. Figures placed in a landscape orientation should have the bottom of the figure on the right side of the page. In this orientation, the proper page margins and page numbers must be adhered to as if the figure were in a portrait orientation (left, right and bottom margins at 1 in., top at 1.5 in.). The figure title should be oriented with the figure. The page number should be in the usual position as if the figure were in a portrait orientation.

The legend of the figure should be in the same font and size as the rest of the text. Any text in the figure should be readable (no smaller than 10 point). A different font may be used within figures, e.g. a sans serif font to improve readability. Use color with caution, since many colors do not reproduce well. Use of gray scale for images is recommended if the figure can be adequately represented. The use of cross-hatching and broken lines to denote differences is suggested.  An example of a figure and how it should be labeled can be seen below.

[image: ]
Figure 1.  Pretest and Posttest scores on a test of concentration. 

[bookmark: _Toc24368453]Citations

References should be cited within the text according to either the target journal’s specifications or APA guidelines.  Typical styles include the author-date method (e.g. Block, 2006 or Block et al. 2004)) and the numbering method (e.g.1 (1), (2), (3) or 1, 2, 3 etc.).

[bookmark: _Toc24368454]References

All references cited in the text, including those in tables, figures, and abstract and other non-text sections, must be listed at the end of the text, before the appendices.  Reference citation format should follow APA style or the target journal’s guidelines. A separate title page is not included prior to the listing of References.

The word “REFERENCES” should be 2 in. (5.08 cm) from the top of the page (all caps, centered, and bold, same as a Main Section type heading) followed by a list of all references cited in the manuscript.  Only references that were actually cited in the document or its appendices may appear in the list.  All references should be single-spaced within the reference and double-spaced between the references.  Note: the DOI (digital object identifier) for an article is typically found on the first page of the electronic journal article, near the copyright notice and/or on the database landing page for the article.  Examples of references from APA are listed below.  


APA 7 Examples:

Journal Article without DOI: 
Thompson, B. A. (2000). Choice and the consequences of choosing. The Journal of Life Changes, 126, 910-924.

Journal Article with DOI (include DOI whenever possible): 
Herbst-Damm, K. L., & Kulik, J. A. (2005). Volunteer support, marital status, and the survival times of terminally ill patients. Healthy Psychology, 24, 225-229. https://doi.org/10.1037/0278-6133.24.2.225

Journal Article Avaialable Online But With No DOI:
Sillick, T. J., & Schutte, N. S. (2006). Emotional intelligence and self-esteem mediate between perceived early parental love and adult happiness. E-Journal of Applied Psychology, 2(2), 38-48. https://ojs.lib.swin.edu.au/index.php/ejap

Unpublished Thesis or Dissertation:
Florsheim, P. (2008). Mental health help-seeking in ethnic minority populations: A theoretical perspective [Unpublished master’s thesis]. Washington University, St. Louis, MO. 

Published Thesis or Dissertation:
Angeli, E. L. (2012). Networks fo communication in emergency medical services (Publication No. 3544643) [Doctoral dissertation, Purdue University]. ProQuest Dissertations Publishing. 

Book:
Helgeson, T. P., & Saldana, Z. A. (2006). Veterinary medicine and the animals we care 
	For. McGraw-Hill.

[bookmark: _Toc24368455]Appendices

Appendices should follow the Reference section and are used to present information that is not critical to the study or that will be of interest only to some readers.  Appendices commonly include items such as informed consent forms, extra methodological information, surveys, and the review of literature if it is not included in the main body of the text.  These items may or may not be referenced in the text. Appendices are labeled with capital letters (i.e., A, B, C, etc.), according to the order they are referred to in the document.  If the work has fewer than three appendices, the title of each is included under the heading of Appendices at the bottom of the table of contents.  If the manuscript has three or more appendices, a separate list of appendices should follow the list of figures. The individual program manuals have different requirements.  Be sure to follow the specifications of the manual for your area of study.
Each appendix should be preceded by an appendix title page.  This is a mostly blank page with only the following text on it: 
APPENDIX X
TITLE OF APPENDIX X
The above text is centered left to right and vertically on the page (in all caps). The page numbers are visible on the appendix pages, but they are hidden on the appendix title pages. Since the appendix title is provided on the appendix title page, it does not need to be included on the first page of the appendix itself but it may be included if doing so aids in clarity.   

[bookmark: _Toc84922744][bookmark: _Toc24368456]Paper, Quality of Copy, and Reproduction

Manuscripts submitted for archiving in Murphy Library are to be printed single-sided
[bookmark: OLE_LINK1][bookmark: OLE_LINK2]on 8 ½ inch by 11 inch white bond paper, non-erasable, at least 20-pound stock, and at least 25% cotton fiber content. Extra copies may be printed single-sided using paper of lesser weight. Print from a laser or ink jet printer is acceptable for a final copy of the thesis. Final print quality for submission must be produced in high letter quality.
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APPENDIX A

FORMATTING FOR REQUIRED PAGES






REMOVE or REPLACE ALL RED TEXT AND REMINDER BOXES BEFORE PRINTING FORMS!

WHERE YOU SEE “Thesis/Dissertation/Project/Seminar Paper,” SELECT THE CORRECT WORD FOR YOUR WORK AND DELETE THE OTHER WORDS.










UNIVERSITY OF WISCONSIN-LA CROSSE 

Graduate Studies 





TITLE IS UPPERCASE AND CENTERED AND IF A SECOND LINE, IT IS 
DOUBLE-SPACED IN INVERTED PYRAMID FORM






A [Manuscript or Chapter] Style Thesis/Dissertation/Project/Seminar Paper Submitted in Partial Fulfillment of the Requirements for the Degree of [Insert Title] 





Student’s Name 





College of [College Name]
[Clinical Area/Concentration, if applicable]


Month (of graduation: May, August, or December), Year
TITLE IS UPPERCASE AND CENTERED AND IF A SECOND LINE, IT IS DOUBLE-SPACED IN REVERSE PYRAMID FORMThe text boxes are guidelines; delete all of these before printing!
1 inch top and right margins

1 ½ inch left margin


By Student Name



We recommend acceptance of this thesis/dissertation/project/seminar paper in partial fulfillment of the candidate's requirements for the degree of [Insert Degree and Specialty Area].Use the official degree title


The candidate has completed the oral defense of the thesis/dissertation/project/seminar paper.
				Double-check for spelling accuracy of committee member names and titles

Hardy Bellflinger, Ph.D. 			Date
Thesis/Dissertation/Project/Seminar Paper Committee Chairperson
On behalf of the committee members named below:

Windy Meadows, M.D.			

Marty Mambo, M.F.A.		

Add additional names of committee members as needed





Thesis/Dissertation/Project/Seminar Paper accepted
				
Meredith Thomsen, Ph.D. 	             Date
Dean of Graduate & Extended LearningMinimum 1 inch bottom margin



ABSTRACT
Student Last Name, First Initial. Second Initial.. Title of the manuscript. [MS/MPH/Ed.D] in [degree to be received], Month and Year of Graduation, ##pp. (Advisor’s First Initial. Last Name)

The abstract page is the first visibly numbered page of the front matter with a lower case Roman numeral “iii”. (The first two pages, the title page and signature page, have their page numbers hidden but do count towards the total page count.) Page numbers are tricky. Within the ‘Home’ menu in Word there is a button which allows you to reveal formatting, marked with the symbol ¶. If you click this button, you will see that on the previous page, after the text Dean of Graduate & Extended Learning, we have inserted a Section Break (Next Page). You can do this from the ‘Layout’ menu in Word. Now scroll down to the bottom of this page and double-click on the page number. This opens up the Header & Footer Tools menu. A critical step is to properly use the “Link to previous” setting within the Navigation cluster. This page is set up to NOT “Link to previous” because it must be different from the previous section – it must have page numbers showing, in Roman numerals. The Abstract will be page iii. Make sure the page number font matches your document body. All following pages will be part of the same section, and will thus have the same kind of page number (Acknowledgements, Table of Contents, etc.) When you move on to the body of your thesis or dissertation text, you will need to add another section break. In the new section, open up the Header and Footer again, unclick “Link to previous” again, and then change the page number formatting to start numbering with Arabic numerals at number 1.
Read this paragraph for some advice on page numbers. Also check out the formatting videos on the Thesis and Dissertation page of the Graduate Studies website.
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